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Resumen

Acciones de Nautilus es una extensión de Nautilus cuya función principal es permitir al usuario añadir acciones arbitrarias a
los menús contextuales del gestor de archivos. Estas acciones se puede organizar en menús y submenús, y se puede exportar y
compartir con otros entornos de escritorio.

Este manual describe la interfaz de usuario de la Herramienta de configuración de acciones de Nautilus y explica cómo puede
configurar sus menús y sus acciones, haciendo que se muestren y se apliquen dependiendo de condiciones específicas.
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1. Introducción

Acciones de Nautilus es una extensión de Nautilus cuya función principal es permitir al usuario añadir acciones arbitrarias a
los menús contextuales del gestor de archivos. Estas acciones se puede organizar en menús y submenús, y se puede exportar y
compartir con otros entornos de escritorio.

La aplicación Herramienta de configuración de las acciones de Nautilus es la interfaz de usuario que le permite configurar cómo,
dónde y cuándo deberán aparecer sus acciones en los menús contextuales de Nautilus y cómo se ejecutarán.

La Herramienta de configuración de acciones de Nautilus proporciona las siguientes características:

Definir y configurar acciones desde cero.

Organizar acciones en los menús, submenús, etc...

Importar y exportar acciones y menús desde y hacia afuera.

nota
Acciones de Nautilus también tiene características adicionales como:

Un complemento de Nautilus que exporta en tiempo real los archivos seleccionados a D-Bus.

Un programa de línea de comandos capaz de ejecutar cualquier acción.

Asociado con la interfaz D-Bus, este programa permite al usuario ejecutar cualquier acción desde un atajo de teclado,
aplicando esta acción a los elementos seleccionados actualmente en el gestor de archivos.

Un programa de línea de comandos capaz de crear una acción nueva.

Todas estas características se explican ampliamente en la documentación global de Acciones de Nautilus.

2. Inicio

2.1. Iniciar la Herramienta de configuración de las acciones de Nautilus

Puede iniciar la Herramienta de configuración de las acciones de Nautilus de las siguientes maneras:

Menú Sistema Elija Preferencias→ Visualización y comportamiento→ Herramienta de configuración de las acciones de Nau-
tilus.

Línea de comandos Para iniciar la Herramienta de configuración de las acciones de Nautilus desde una línea de comandos,
escriba lo siguiente:

nautilus-actions-config-tool

y pulse Intro.

sugerencia
Para ver las opciones de línea de comandos disponibles, escriba:
nautilus-actions-config-tool --help-all

y pulse Intro.
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2.2. La primera ejecución

Cuando inicia la Herramienta de configuración de las acciones de Nautilus, se muestra la siguiente ventana.

La ventana principal de la Herramienta de configuración de las acciones de Nautilus vacía.

Figura 1: Ventana de inicio de la Herramienta de configuración de las acciones de Nautilus

La ventana principal de la Herramienta de configuración de las acciones de Nautilus contiene los siguientes elementos:

Barra de menú. Los menús de la barra de menús contienen todos los comandos que necesita usar en la Herramienta de confi-
guración de las acciones de Nautilus.

Hay atajos disponibles para algunos comandos:

Ctrl-N Crear una acción nueva.

Ctrl-S Guardar las acciones modificadas y los menús.

Ctrl-Q Salir de la aplicación.

Ctrl-X Cortar la selección actual, dejándola en el portapapeles.

Ctrl-C Copiar la seleccioń al portapapeles.

Ctrl-V Insertar el contenido del portapapeles antes del elemento actual.

Mayús-Ctrl-V Insertar el contenido del portapapeles como subelemento(s) del elemento actual

Eliminar Eliminar la selección actual.

F5 Recargar las acciones y los menús.

F1 Mostrar la ayuda.

Barra de herramientas. Se pueden mostrar varias barras de herramientas debajo de la barra de menú, dependiendo de las
elecciones del submenú Ver→ Barras de herramientas.
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Lista de elementos. La lista de la izquierda de la ventana principal contiene todos los elementos, ya sean acciones o menús,
actualmente disponibles para editarlos en la Herramienta de configuración de las acciones de Nautilus.

Los elementos se puede clasificar alfabéticamente de manera ascendente o descendente, o no clasificarse, organizándolos
y administrándolos directamente el usuario.

Los elementos no válidos se muestran en color rojo.

Los elementos modificados se muestran en caracteres en cursiva.

Ordenar botones Tres botones le permiten conmutar entre de modos de ordenación.

Pestañas de propiedades. La parte derecha de la ventana principal mostrará todo lo necesario para definir cómo, cuándo y
dónde se mostrarán las acciones y los menús.

Acción/Menú Definir en qué menús de Nautilus debe aparecer el elemento, y cómo debe aparecer.

Comando Especifique qué comando quiere ejecutar, y qué parámetros quiere pasarle.

Ejecución Especifique como quiere ejecutar el comando.

Nombres base Defina los filtros de nombres base que debe cumplir la selección de Nautilus antes de mostrarse la acción
o menú candidato.

Tipos MIME Defina los filtros de tipos MIME que debe cumplir la selección de Nautilus antes de mostrarse la acción o
menú candidato.

Carpetas Defina los filtros de carpetas que debe cumplir la selección de Nautilus antes de mostrarse la acción o menú
candidato.

Esquemas Defina los filtros de esquemas que debe cumplir la selección de Nautilus antes de mostrarse la acción o menú
candidato.

Prestaciones Defina los filtros de prestaciones que debe cumplir la selección de Nautilus antes de mostrarse la acción o
menú candidato.

Entorno Defina alguna condición de entorno que debe cumplir la selección de Nautilus antes de mostrarse la acción o
menú candidato.

Propiedades Mostrar las propiedades del elemento.

Barra de estado. La barra de estado muestra alguna información del estado actual de la fila seleccionada actualmente en la lista
de elementos.

Cuando no hay información relevante para mostrar, la barra de estado muestra la cuenta de menús, acciones y perfiles
cargados.

El icono de «sólo lectura» se mostrará a la derecha de la barra de estado cuando sea apropiado.

2.3. Crear su primera acción

En este ejemplo, se va a mostrar una acción que muestre alguna información sobre la selección actual.

Comprobando los prerrequisitos Esta acción requiere Zenity.

Zenity es un programa que le permite crear una interfaz gráfica de usuario desde la linea de comandos.

Debe comprobar que este programa esté instalado en su sistema, por ejemplo escribiendo en una terminal el siguiente comando:

zenity

y pulse Intro.

Crear la acción Para crear una acción nueva, elija Archivo→ Acción nueva (Ctrl-N).

Se inserta una acción nueva en la lista de elementos y sus propiedades se muestran en las pestañas del panel derecho.

La etiqueta de la acción editada actualmente (ésta misma) se añade al nombre de la aplicación en la barra de título.
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Propiedades predeterminadas de una acción nueva

Figura 2: Propiedades predeterminadas de una acción nueva

En la Lista de elementos, la acción nueva se muestra con los caracteres en cursiva.

Las cursivas se utilizan como recordatorio de que el elemento aún no se ha guardado.

Como otro recordatorio de que hay algunas modificaciones pendientes, un asterisco (« * ») precede al nombre de la aplicación
en la barra de título.

Calificar su acción nueva Simplemente consiste en elegir cómo su acción se mostrará en el menú contextual del gestor de
archivos.

Escriba Mi primera acción en el caja de entrada Etiqueta de contexto.

El cuadro de texto Etiqueta de contexto contiene la etiqueta de la acción que se quiere mostrar en el menú contextual del gestor
de archivos.

La etiqueta es una propiedad obligatoria de la acción. Si se encuentra vacía, entonces la Herramienta de configuración de las
acciones de Nautilus considerará no válida la acción: se mostrará en rojo en la Lista de elementos y nunca será candidata a
mostrarse en el menú contextual del gestor de archivos.

Escriba Esto ejecutará una acción con algunos parámetros en el cuadro de texto Consejo.

El cuadro de texto Consejo contiene el texto que quiere mostrar como una ayuda breve sobre la acción.

Seleccione en la lista desplegable Icono.

La selección del Icono determina el icono que se asociará con su acción en el menú contextual del gestor de archivos y en la
barra de tareas.

Tiene dos formas de elegir el icono asociado a su acción:

• Pulse sobre la lista desplegable Icono para seleccionar un icono.
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• Pulse sobre Examinar para buscar una imagen en el sistema de archivos.

Especificar el comando que ejecutar Cuando se seleccione su acción en el menú contextual del gestor de archivos, este comando
se ejecutará con los argumentos de su elección.

Pulse en la pestaña Comando para mostrar la página que le permitirá introducir el comando.

Pestaña «Comando»

Figura 3: Pestaña «Comando»

Escriba zenity en el cuadro de texto Ruta.

El cuadro de texto Ruta establece el comando que se ejecutará cuando seleccione su acción en el menú contextual del gestor
de archivos.

Tiene dos formas de definir el comando que ejecutar:

• Escríbalo en el cuadro de texto Ruta.

• Pulse sobre Examinar para seleccionar un archivo ejecutable en el sistema de archivos.

Si el comando que escriba con contiene una ruta absoluta, se buscará en la variable PATH en tiempo de ejecución.

Enter --info --text=’%c selected item(s):%U’ in the Parameters entry box.

The Parameters contains the arguments which will be passed to your command when it will be executed. These arguments
may embed parameters which will be expanded at runtime.

If both Path and Parameters are empty, then this action will be considered as invalid: it will be displayed in red in Items list
and will be never be candidate to be displayed in the file manager context menus.

Guardado To save all pending modifications, choose File→ Save (Ctrl-S).

Nautilus automatically takes into account your new action, and displays it in its context menu.
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Your first action in the Nautilus context menu

Figura 4: Your first action in the Nautilus context menu

Cliking of the item in the Nautilus context menu activates it, and executes the corresponding command.

The result of the execution of your first action

Figura 5: The result of the execution of your first action
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3. Usar la Herramienta de configuracioń de acciones de Nautilus

3.1. Definir las condiciones

Whether your action will eventually be displayed in Nautilus file manager context menus or in its toolbar depends on the condi-
tions you will have defined for it.

Conditions may be put against the location the file manager currently points to, or against the currently selected items in this
location.

Each time the selection or the location change in the file manager, Nautilus-Actions checks all your actions, comparing the
defined conditions against the new location and selection: all defined conditions must be satisfied in order your action be actually
displayed.

3.1.1. Basename-based conditions

You may decide that your action will appear depending on the basenames of the items currently selected in the file-manager: you
may define that each item of the selection must meet some sort of basename, and you may simultaneously decide that none of
the selected item(s) can have some other sort of basename.

Click on the Basenames tab to show the page which will permit you to configure your basename-based conditions.

The basename-based conditions tab

Figura 6: Basename-based conditions

In fact, basename-based conditions are built as a list of « must match one of » and « must not match any of » patterns. In order
for your action to be a candidate regarding these basename-based conditions, each element of the selection must be valid for all
the listed conditions: the basename of each element must match at least one of the defined « must match one of » patterns, and
must not match any of the defined « must not match any of » patterns.
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If at least one element of the selection does not match all the defined conditions, then your action will not be displayed.

When targeting the selection context menu, your basename-based conditions will be checked against the currently selected items.
When targeting the location context menu or the toolbar, your basename-based conditions will be checked against the basename
of the current location.

Defining a new basename-based condition involves two steps.

1. Define the new condition filter.

Press Insert or click on button to insert a new condition filter

Edit the newly inserted condition filter to the basename you want match.

sugerencia
A basename-based condition may use « * » or « ? » wildcard characters.

2. Indicates whether this a « must match one of » or a « must not match any of » condition.

Click on the Must match one of or Must not match any of radio button in the same row to set the corresponding condition.

Depending of your target operating system, make sure that the Match case checkbox is activated (or not).

When activated, all filters are considered as case sensitive, which means that /my/file filename is considered distinct from
/My/File one.

This is the default behavior on Unix-like systems.

When deactivated, filters are considered as case insensitive, which means that /my/file and /My/File filenames are
considered the same name.

This is most probably what you want if you target some sort of Windows system.

Removing a defined basename-based condition is as simple as selecting it, and pressing Del (or clicking on button).

By default, the basename-based condition is just one « must match one of * » condition. As all basenames always match
the « * » condition, this just means that basename-based conditions are not considered as relevant for the action.

3.1.2. Condiciones basadas en tipos MIME

You may decide that your action will appear depending on the mimetypes of the items currently selected in the file-manager: you
may define that each item of the selection must meet some sort of mimetype; and you may simultaneously decide that none of
the selected item(s) can have some other sort of mimetype.

Click on the Mimetypes tab to show the page which will permit you to configure your mimetype-based conditions.
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The mimetype-based conditions tab

Figura 7: Condiciones basadas en tipos MIME

In fact, mimetype-based conditions are built as a list of « must match one of » and « must not match any of » patterns. In order
for your action to be a candidate regarding these mimetype-based conditions, each element of the selection must be valid for all
the listed conditions: the mimetype of each element must match at least one of the defined « must match one of » patterns, and
must not match any of the defined « must not match any of » patterns.

If at least one element of the selection does not match all the defined conditions, then your action will not be displayed.

When targeting the selection context menu, your mimetype-based conditions will be checked against the currently selected items.
When targeting the location context menu or the toolbar, your mimetype-based conditions will be checked against the mimetype
of the current location, which happens to be the well known « inode/directory » mimetype.

Defining a new mimetype-based condition involves two steps.

1. Define the new condition filter.

Press Insert or click on button to insert a new condition filter
Edit the newly inserted condition filter to the mimetype you want match.
A mimetype must be defined as a group/subgroup expression.

sugerencia
The « * » wildcard is supported only in some situations:

• The « */* » expression matches all mimetypes. As a convenient shortcut, the « * » literal is also accepted for this
same purpose.

• A group/* string matches all subgroups of group mimetype.

• The */subgroup string is not accepted as a valid wildcard.
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2. Indicates whether this a « must match one of » or a « must not match any of » condition.

Click on the Must match one of or Must not match any of radio button in the same row to set the corresponding condition.

Removing a defined mimetype-based condition is as simple as selecting it, and pressing Del (or clicking on button).

By default, the mimetype-based condition is just one « must match one of */* » condition. As all mimetypes always
match the « */* », this just means that mimetypes are not considered as relevant for the action.

Ejemplo 3.1 Ejemplo de tipos MIME habituales

all/all Matches all items.

all/allfiles Matches all regular files.

inode/directory Matches only directories.

3.1.3. Condiciones basadas en carpetas

You may decide that your action will appear depending on the directory the items currently selected in the file-manager are located
in: you may define that each item of the selection must be located in one hierarchy or in another; and you may simultaneously
decide that none of the selected item(s) can be located in some other hierarchy.

A folder-based condition must be understood as the specification of the hierarchy in which the currently examined item should
(or should not) stay: this is a pattern on the dirname of the element.

Click on the Folders tab to show the page which will permit you to configure your folder-based conditions.

The folder-based conditions tab

Figura 8: Condiciones basadas en carpetas



Manual del usuario de la Herramienta
de configuración de las acciones de
Nautilus 11 / 0

In fact, folder-based conditions are built as a list of « must match one of » and « must not match any of » patterns. In order for
your action to be a candidate regarding these folder-based conditions, each element of the selection must be valid for all the listed
conditions: each element must be located in one of the defined « must match one of » folders, and must not match any of the
defined « must not match any of » folders.

If at least one element of the selection does not match all the defined conditions, then your action will not be displayed.

When targeting the selection context menu, your folder-based conditions will be checked against the dirname of each currently
selected items. When targeting the location context menu or the toolbar, your folder-based conditions will be checked against the
current location.

Defining a new folder-based condition involves two steps.

1. Define the new condition filter.

Press Insert or click on button to insert a new condition filter

Edit the newly inserted condition filter to the folder you want match.

sugerencia
The « * » and « ? » characters are accepted as wildcards at any level of the defined folder filter.

Or click on Browse to select a folder on the file system.

2. Indicates whether this a « must match one of » or a « must not match any of » condition.

Click on the Must match one of or Must not match any of radio button in the same row to set the corresponding condition.

Removing a defined folder-based condition is as simple as selecting it, and pressing Del (or clicking on button).

By default, the folder-based condition is just one « must match one of / » condition. As / is always the top of an Unix-
like file system, then all selected items always match this condition.

nota
If you target a Windows system, then this default value may not be what you actually want.

3.1.4. Condiciones basadas en esquemas

You may decide that your action will appear depending on the schemes of the URIs of the items currently selected in the file-
manager: you may define that each item of the selection must have some scheme; and you may simultaneously decide that none
of the selected item(s) may have some other scheme.

Click on the Schemes tab to show the page which will permit you to configure your scheme-based conditions.
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The scheme-based conditions tab

Figura 9: Condiciones basadas en esquemas

In fact, scheme-based conditions are built as a list of « must match one of » and « must not match any of » patterns. In order for
your action to be a candidate regarding these scheme-based conditions, each element of the selection must be valid for all the
listed conditions: the scheme of each element must match at least one of the defined « must match one of » patterns, and must
not match any of the defined « must not match any of » patterns.

If at least one element of the selection does not match all the defined conditions, then your action will not be displayed.

When targeting the selection context menu, your scheme-based conditions will be checked against the currently selected items.
When targeting the location context menu or the toolbar, your scheme-based conditions will be checked against the scheme of
the current location.

Defining a new scheme-based condition involves two steps.

1. Define the new condition filter.

Press Insert or click on button to insert a new condition filter

Edit the newly inserted condition filter to the scheme you want match.

sugerencia
Scheme-based conditions only accept « * » wildcard, which stands for « any scheme ».

Or click on Common to select a scheme among those predefined in Edit→ Preferences.
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Selecting a scheme among predefined defaults

Figura 10: Selecting a scheme among predefined defaults

A new scheme may only be selected here if it is not already defined as a scheme filter.
To select a new scheme, click OK, or double-click on the desired row.

2. Indicates whether this a « must match one of » or a « must not match any of » condition.

Click on the Must match one of or Must not match any of radio button in the same row to set the corresponding condition.

Removing a defined scheme-based condition is as simple as selecting it, and pressing Del (or clicking on button).

By default, the scheme-based condition is just one « must match one of * » condition, which means that schemes are not
relevant for this action.

3.1.5. Capability-based conditions

Capabilities are some properties that a file may exhibit to the user.

But except for the Local capability, all others depend on the user who executes the command.

You may so decide that your action will appear, or not, depending on the capabilities of the selected item(s) vs. the current user.

Click on the Capabilities tab to show the page which will permit you to configure your capability-based conditions.
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The capability-based conditions tab

Figura 11: Capability-based conditions

In fact, capability-based conditions are built as a list of « must match all of » and « must not match any of » patterns. In order for
your action to be a candidate regarding these capability-based conditions, each element of the selection must be valid for all the
listed conditions: the capability of each element must match each of the defined « must match all of » capabilities, and must not
match any of the defined « must not match any of » ones.

If at least one element of the selection does not match all the defined conditions, then your action will not be displayed.

When targeting the selection context menu, your capability-based conditions will be checked against the currently selected items.
When targeting the location context menu or the toolbar, your capability-based conditions will be checked against those of of the
current location.

Defining a new capability-based condition involves two steps.

1. Define the new condition filter.

Press Insert to insert a new condition filter

Edit the newly inserted condition filter to the capability you want match.

Or click on to open the Adding a new capability dialog box.
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The list of managed capabilities

Figura 12: Managed capabilities

A new capability may only be selected here if it is not already defined as a capability filter.
To select a new capability, click OK, or double-click on the desired row.

2. Indicates whether this a « must match all of » or a « must not match any of » condition.

Click on the Must match all of or Must not match any of radio button in the same row to set the corresponding condition.

Removing a defined capability-based condition is as simple as selecting it, and pressing Del (or clicking on button).

By default, the capability-based condition list is empty. This means that capabilities are not relevant for this action.

3.1.6. Selection count condition

You may define that your action will only appear if the current selection in the file manager has some precise count, or some
precise relation with a given count.

Ejemplo 3.2 A selection count use case
If your action consists in displaying the differences between two files, you may define here « Count = (equal to) 2 ».

Click on the Environment tab to show the page which will permit you to configure your environment-based conditions.
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The environment-based conditions tab

Figura 13: Environment-based conditions

The selection count condition is defined in the Appears if selection contains frame.

Selection count condition frame

Figura 14: Selection count condition frame

When targeting the selection context menu, the count condition defined here will be checked against the count of currently
selected items. When targeting the location context menu or the toolbar, the count condition will be checked against zero because
there is no selected item in this case.

To define a selection count condition:

Select in the Count drop-down list the operator you want apply to the selection count:
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< (estrictamente menor que)
= (igual a)
> (estrictamente mayor que)

Enter the reference count you wish.

The selection count defaults to « Count > (strictly greater than) 0 », which means that the action will be a
candidate to be displayed as soon as at least one item is selected in the file manager.

3.1.7. Desktop selection

Debe definir que su acción:

aparecerá siempre,

o aparecerá sólo en algunos entornos de escritorio,

o no aparecerá en algunos entornos de escritorio.

Sólo es posible elegir uno de estos tres elementos.

Click on the Environment tab to show the page which will permit you to configure your environment-based conditions.

The desktop selection is defined in the Desktop environment frame.

Desktop selection frame

Figura 15: Desktop selection frame

To define the desktop environment condition:

1. Primero seleccione el tipo de filtro:

should your action always appear, regardless of the desktop environment ?
should your action only appear in some desktop environment(s) ?
should your action never appear in some desktop environment(s) ?

2. If your action should not always appear, then select the relevant desktop environment(s) in the listbox in the right side.

The targeted desktop environment condition defaults to « Always appear », which means that the action will be a candidate
to be displayed regardless of the current desktop environment.
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3.1.8. Executable found condition

You may define that your action will only appear if some prerequisite package is installed on your system. This is checked here
by specifying that a specific file, known or at least supposed to be provided by the package, must be present on the file system,
and executable.

Click on the Environment tab to show the page which will permit you to configure your environment-based conditions.

The executable found condition is defined in the Execution environment frame.

Execution environment frame

Figura 16: Execution environment frame

To define the relevant file, enter its full filename in the Appears if the file is executable entry box, or click on Browse to select a
file on the file system.

Deje el campo vacío si esta condición no es relevante para su acción.

sugerencia
You may embed some parameters in the searched filename. These parameters will be dynamically substituted at runtime with
values which will depend on currently selected item(s).

3.1.9. D-Bus registration condition

You may define that your action will only appear if some given name is registered on the D-Bus system at runtime.

Click on the Environment tab to show the page which will permit you to configure your environment-based conditions, and focus
on Execution environment frame.

To define the relevant name, enter it in the Appears if the name is registered on D-Bus entry box.

Deje el campo vacío si esta condición no es relevante para su acción.

sugerencia
You may embed some parameters in the searched name. These parameters will be dynamically substituted at runtime with
values which will depend on currently selected item(s).
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3.1.10. Condición personalizada

You may define that your action will only appear if some given command outputs a true string on its standard output.

Click on the Environment tab to show the page which will permit you to configure your environment-based conditions, and focus
on Execution environment frame.

This lets you define your own customized condition filter, by writing a small script which outputs, or not, the true string on
stdout when it is ran.

To define the command, enter it in the Appears if the command outputs "true" entry box.

Deje el campo vacío si esta condición no es relevante para su acción.

sugerencia
You may embed some parameters in the executed filename or its options. These parameters will be dynamically substituted at
runtime with values which will depend on currently selected item(s).

3.1.11. Running process condition

You may define that your action will only appear if some given binary is currently running.

Click on the Environment tab to show the page which will permit you to configure your environment-based conditions, and focus
on Execution environment frame.

To define the binary, enter its name in the Appears if the binary is running entry box, or click on Browse to select a file on the file
system.

nota
Even if you enter here the full filename of a binary, only its basename will be searched for in the processes list at runtime.

Deje el campo vacío si esta condición no es relevante para su acción.

sugerencia
You may embed some parameters in the searched name. These parameters will be dynamically substituted at runtime with
values which will depend on currently selected item(s).
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3.2. Locating the action

Target configuration

Figura 17: Target configuration

Nautilus file manager may display your action in different places, depending on what you will request here, and if some item is
currently selected (or not).

Click on the Action tab to show the page which will permit you to configure the locations your action targets.

3.2.1. Targeting the selection context menu

When Display item in selection context menu is checked, then your action will be a candidate to be displayed in Nautilus’ context
menu as soon as at least one item is selected in the file manager. Your action will so deal with currently selected item(s).In order
to be actually displayed, all the conditions defined in your candidate action must be met by each item currently selected in the
Nautilus file manager.

sugerencia
When an action targets the selection context menu, and is actually displayed in Nautilus’ context menu, then it is also displayed
in Nautilus’ Edit menu.

This target is checked by default.

3.2.2. Targeting the location context menu

When Display item in location context menu checkbox is activated, then your action will be a candidate to be displayed in
Nautilus’ context menu when the file manager selection is empty. Your action will so deal with currently displayed location. In
order to be actually displayed, all the conditions defined in your candidate action must be met by the location currently displayed
in the Nautilus file manager.

sugerencia
When an action targets the location context menu, and is actually displayed in Nautilus’ context menu, then it is also displayed
in Nautilus’ File menu.
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3.2.3. Targeting the toolbar

When Display item in the toolbar checkbox is activated, then your action will be a candidate to be displayed in Nautilus’ toolbar.

Actions displayed in the toolbar only deal with the location which is currently displayed in the file-manager, not with the items
which may be currently selected (or not). In order to be displayed, all the conditions defined in your candidate action must so be
met by the current location.

3.2.4. Notas

If your action is to be displayed in a context menu Whether it is the selection context menu or the location context menu, and
both in Nautilus’ context menus and in File or Edit menus, it will be displayed as

the Context label as a label,

the Icon,

these two properties being associated with the Tooltip.

nota
Depending of the exact configuration of your desktop environment, the icon may or may not be displayed in front of the label in
the menu.

sugerencia
You may embed some parameters in the label, the icon name or the tooltip. These parameters will be dynamically substituted
at runtime with values which will depend on currently selected item(s).

If your action is to be displayed in the toolbar Se mostrará como

the Toolbar label as a label,

the Icon,

these two properties being associated with the Tooltip.

nota
Depending of the exact configuration of your desktop environment, the toolbar label may or may not be displayed in front of the
icon in the toolbar.

sugerencia
The toolbar label defaults to the same label as those used in menus. By unchecking the Use same label for icon in the toolbar
checkbox you can define a label specific to the toolbar, which is usually shorter that those defined for the menus.

sugerencia
You may embed some parameters in the toolbar label, the icon name or the tooltip. These parameters will be dynamically
substituted at runtime with values which will depend on currently selected item(s).

Definir varios objetivos An action may target the selection context menu, the location context menu and the toolbar, or one or
more of these.

Defining no target at all If no target is defined, i.e. if the three checkboxes are unchecked, then your action will never be
displayed.
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3.3. ¿Qué acción se debe ejecutar?

You most probably want that your action eventually ends up in executing something. And, as a matter of fact, having something
to execute is one of the few conditions which are required for an action to be considered as valid.

As we have already seen, the command to be executed is configured in the Command page.

This command may take arguments, which themselves may embed parameters. These parameters will be expanded at runtime,
with values which will depend on currently selected item(s).

3.3.1. Parámetros disponibles

En la página Comando, pulse en el botón Leyenda para ver la lista de parámetros disponibles.

Los parámetros disponibles

Figura 18: Lista de parámetros disponibles

sugerencia
The Legend button has a toggling action: click once to display the Parameter Legend dialog box; click a second time to hide it.
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nota
The word « first » may be misleading as it only refers to the list of selected items internally provided by the file manager to the
Nautilus-Actions plugin.
In particular, it has nothing to do with the visual selection you may have done in the file manager window. And, in fact, which is
the « first » selected item in a multiple selection is absolutely undefined and rather unpredictable.

3.3.2. ¿Dónde se debe ejecutar la acción?

Your action may be executed in a particular working directory.

You may specify it in the Command tab, in the Working directory entry box, or by clicking on Browse to select a folder on the
filesystem.

Working directory frame

Figura 19: Working directory frame

The working directory defaults to%d, which runs the command in the base directory of the (first) selected item.

In the particular case of the%d parameter, the « first » selected item is not very important because it is very likely that all selected
items are located in the same base directory.

3.3.3. ¿Cómo se debe ejecutar la accioń?

Apart from configuring the conditions, the selection must met in order your action be displayed in file manager menus, Nautilus-
Actions allows you to configure how exactly your command will be executed.

Pulse en la pestaña Ejecutar para mostrar la página que le permitirá configurar la ejecución de su comando.
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Configuración de los modos de ejecución

Figura 20: Configuración de los modos de ejecución

3.3.3.1. Modo de ejecución

Configuracioń del modo de ejecucioń

Figura 21: Configuracioń del modo de ejecucioń

The execution mode of your command may be chosen between following values:

Normal Starts the command as a standard graphical user interface.
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Terminal Starts the preferred terminal of the desktop environment, and runs the command in it.

Empotrado Makes use of a special feature of the file manager which may allow a terminal to be ran in it.

As Nautilus does not have this feature, this option is strictly equivalent to Terminal option.

Display output Starts the preferred terminal of the desktop environment, and runs the command in it. At end, standard streams
(stdout, stderr) are collected and displayed.

The execution mode of a command defaults to Normal. That is, the command is executed without any particular pre- or post-
work.

3.3.3.2. Notificación de inicio

Configuration of the startup modes

Figura 22: Configuration of the startup modes

If the execution mode of the command is Normal, and if you know that the application will send a remove message with the
DESKTOP_STARTUP_ID environment variable set, then check the Startup notify checkbox.

See the Startup Notification Protocol Specification for more details.

3.3.3.3. Window class

If the execution mode of the command is Normal, and if you know that the application will map at least one window with a
given class name, then enter that name into the Startup Window Manager class entry box.

See the Startup Notification Protocol Specification for more details.

http://www.freedesktop.org/Standards/startup-notification-spec
http://www.freedesktop.org/Standards/startup-notification-spec
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3.3.3.4. Owner of the execution

Configuration of the owner of the run

Figura 23: Configuration of the owner of the run

Enter in the Execute as user entry box the username or the UID of the user your command will be run as.

If you do not enter anything in this field, then the command will be executed as the current user.

3.3.3.5. Multiple executions

You may want your command to be executed once, providing it the list of selected items as argument.

Or you may prefer your command to be repeated for each selected item, providing a different item as argument for each execution.

Actually, Nautilus-Actions automatically handles these two behaviors, depending of the form and the order of the parameters in
the command arguments.

Though some parameters are not depending on the count of the selection (e.g. «%c », the selection count itself), most have two
declensions:

a « singular » one, e.g. «%b », the basename of the selected item;

a « plural » one, e.g. «%B », the space-separated list of the basenames of selected items.

When the selection is empty or contains only one element, and from this topic point of view, these two forms are exactly
equivalent.

When the selection contains more than one item:

if the first relevant parameter is of a singular form, then Nautilus-Actions will consider that the command is only able to deal
with one item at a time, and thus that it has to be ran one time for each selected item;

contrarily, if the first relevant parameter found is of the plural form, then Nautilus-Actions will consider that the command is
able to deal with a list of items, and thus the command will be executed only once;

if all found parameters are irrelevant, then Nautilus-Actions defaults to consider that the command should be executed only
once.
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Parámetro Descripción Repetition
%b (primer) nombre base singular
%B space-separated list of basenames plural
%c count of selected items irrelevante
%d (primera) carpeta base singular
%D space-separated list of base directory of each selected items plural
%f (primer) nombre de archivo singular
%F space-separated list of selected filenames plural
%h nombre del servidor del (primer) URI irrelevante
%m tipo MIME del (primer) elemento seleccionado singular
%M space-separated list of the mimetypes of the selected items plural
%n nombre de usuario del (primer) URI irrelevante
%o no-op operator which forces a singular form of execution singular
%O no-op operator which forces a plural form of execution plural
%p nuḿero de puerto del (primer) URI irrelevante
%s esquema del (primer) URI irrelevante
%u (primer) URI singular
%U space-separated list of selected URIs plural
%w (first) basename without the extension singular
%W space-separated list of basenames without their extension plural
%x (primera) extensioń singular
%X space-separated list of extensions plural
%% the «% » character irrelevante

Cuadro 1: Characterization of the parameters vs. multiple execution

Ejemplo 3.3 Usage of singular vs. plural forms
Say the current folder is /data, and the current selection contains the three files pierre, paul and jacques.
If we have requested echo %b, then the following commands will be successively run:

echo pedro
echo pablo
echo juan

This is because%b marks a singular parameter. The command is the run once for each of the selected items.
Contrarily, if we have requester echo %B, then the following command will be run:

echo pedro pablo juan
This is because%B marks a a plural parameter. The command is then run only once, with the list of selected items as arguments.
If we have requested echo %b %B, then the following commands will be successively run:

echo pedro pedro pablo juan
echo pablo pedro pablo juan
echo juan pedro pablo juan

This is because the first relevant parameter is%b, and so the command is run once for each selected item, replacing at each
occurrence the%b parameter with the corresponding item. The second parameter is computed and added as arguments to the
executed command.
And if we have requested echo %B %b, then the following commands will be run:

echo pedro pablo juan pedro
This is because the first relevant parameter here is%B. The command is then run only once, replacing%Bwith the space-separated
list of basenames. As the command is only run once, the%b is substituted only once with the (first) basename.

3.4. Using profiles to extend your action

There is some situations where you will want a given action behave slightly differently depending on the currently selected items
or the current runtime environment.
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Ejemplo 3.4 Abrir una terminal aqui
Say you have an action which opens a terminal in the current location.
You have configured it to open your preferred terminal in the location your file manager currently points to.
But what if you want select a directory in your file manager, and directly opens your terminal in this directory ? If you keep based
on the current file manager location, your terminal will open in the parent of the targeted directory.
One solution is to define a new profile to your action, configuring this profile to open the terminal in the targeted directory.
At runtime, Nautilus-Actions will successively examine each profile attached to your action. If the first profile targets a file while
you have selected a directory, then Nautilus-Actions will just try with your second profile.

To create a new profile, first select the action in the items list, then choose File→ New profile.

A new profile is created in your action.

You can now define the conditions which are to be met in order this profile be selected, and the command which will be executed.

3.4.1. Ordering the profiles inside an action

At runtime, Nautilus-Actions will begin with examining the conditions set on your action.

If these conditions (the action-conditions) are met, then Nautilus-Actions will examine in order each profile.

If the conditions defined in a profile are met, then this profile will be validated, and the review of other profiles will stop.

If no profile is found valid at runtime, then the action will be itself considered invalid, and will not be displayed in the file manager
context menu.

Profiles of an action are ordered, and they are examined in that order at runtime. The first profile whose conditions are met will
be validated, and made selectable in the Nautilus context menu.

So, ordering of the profiles may be important for your action: the first valid profile found is the only one selected.

You may order your profiles inside an action in two ways.

1. Cut the profile to be moved, select the profile before which you want your cut profile to be inserted, and paste it.

2. Click on the profile to be moved, and drag it to its right place.

3.5. Organizar acciones en menús

As your list of actions will grow, you most probably will want to organize them into menus, submenus, and so on.

In order to create a new menu, choose File→ New menu.

A menu may be created anywhere in the list of your actions, but inside of an action (i.e. not between two profiles of an action).

As an action, the exact place where a new menu will be inserted depends on the current sort order:

Orden manual: The new menu is inserted just before the current action or menu.

This place will not change when you later modify the label of the menu.

Ascending (resp. descending) alphabetical order: The new menu is inserted at the correct place, regarding the default « New
Nautilus menu » label.

This place will be automatically changed, each time you modify the label of the menu.

As an action, too, a menu requires a label, and may have an icon and a tooltip. Also, you may define some conditions in order
your menu be candidate to be displayed in Nautilus context menu. If the defined conditions are not met at runtime, then your
whole menu, including its submenus, its actions and so on, will not be displayed.
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3.6. Ordenar la lista de elementos

Your actions and menus will be displayed in file manager context menus in the same order that they are listed in the Items list,
on the left pane of the main Nautilus-Actions Configuration Tool window.

You may decide to:

sort your actions and menus in ascending or descending alphabetical order of their label,

or do not sort, and manually organize your actions and menus in your own order.

3.6.1. Alphabetically sorting your actions and menus

In these modes, actions and menus are sorted depending of their label, inside of their parent.

Sort buttons in the main window

Figura 24: Sort buttons in the main window

You may sort your actions by:

Click on (resp. ) button to sort your actions in ascending (resp. descending) order.

Or edit the corresponding preference.

3.6.2. Manually organizing your actions and menus

When items are manually sorted in the list, new items are usually inserted just at the current position.

There is nonetheless the case where an action is selected, and not expanded (or has currently only one profile). Inserting a new
profile will not insert it before the action, but inside of the action.

Para elegir este modo:

Click on button.

Or edit the corresponding preference.

3.7. Editando

With Nautilus-Actions Configuration Tool, you may safely cut, copy, paste to and from the clipboard.
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3.7.1. Cut/Delete

Deletion applies to current selection.

Be warned that selecting and deleting all profiles of an action leaves it without any profile, so in an invalid state. The name of the
action will be written in red (because it is invalid) italic (because it has been modified) characters.

3.7.2. Selección múltiple

Multiple selection is possible in Nautilus-Actions Configuration Tool. You can extend the current selection by pressing Ctrl or
Shift while selecting an item to add to the selection.

Nautilus-Actions Configuration Tool only accepts homogeneous multiple selections. That is, you may select one or more profiles,
or one or more actions or menus. A multiple selection containing both profiles and actions or menus is not allowed. This is because
Nautilus-Actions Configuration Tool would not know where to paste such a selection.

Note that selecting any row means also selecting children of this row. These children are said « implicitely selected »: they
will be part of next edition operations, but are not considered when verifying if selection is homogeneous. Also, they cannot be
explicitely selected (nor unselected).

3.8. Guardar sus cambios

To save your modifications, choose File→ Save (Ctrl-S).

All your pending modifications will be saved. New items will be created by the first available writable I/O provider.

Acciones de Nautilus también tiene una característica de auto-guardado configurable en el cuadro de diálogo Preferencias.

3.9. Exportar sus acciones

3.10. Acciones de importación

3.11. Setting your own preferences

Elija Editar→ Preferencias para acceder a la configuración de sus preferencias.
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3.11.1. Preferencias de ejecución

Preferencias de ejecución

Figura 25: Preferencias de ejecución
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3.11.2. Preferencias de tiempo de ejecución

Preferencias de tiempo de ejecución

Figura 26: Preferencias de tiempo de ejecución
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Desktop selection

Figura 27: Desktop selection
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3.11.3. Preferencias de la interfaz de usuario

Preferencias de la IU

Figura 28: Preferencias de la IU
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3.11.4. Preferencias de importación

Preferencias de importación

Figura 29: Preferencias de importación



Manual del usuario de la Herramienta
de configuración de las acciones de
Nautilus 36 / 0

3.11.5. Preferencias de exportación

Preferencias de exportación

Figura 30: Preferencias de exportación
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3.11.6. Preferencias de esquemas

Preferencias de esquemas

Figura 31: Preferencias de esquemas
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3.11.7. I/O providers preferences

I/O providers preferences

Figura 32: I/O providers preferences

4. Miscellaneous informations

The new action is also displayed in red color in the items list. Red color is used as an indicator that the item is invalid, that
is that the item cannot be candidate to be displayed in a Nautilus context menu because some of its informations are missing
or erroneous. Here, and though this newly inserted action has some suitable defaults, it lacks a command to be executed to be
considered valid by Nautilus-Actions Configuration Tool

5. Errores conocidos y limitaciones

5.1. Errores conocidos

Known bugs are available on Bugzilla summary page.

If you find some new bug in Nautilus-Actions, you are welcome to open it by pointing your favorite browser to Bugzilla web site.

#616532 Directory selection When you’re browsing the folder you want to export to in the Nautilus-Actions Configuration
Tool’s export assistant you can’t select it as the directory to export to. Instead you have to go to the directory a level up and select
the directory you want to export to there.

https://bugzilla.gnome.org/buglist.cgi?product=nautilus-actions&bug_status=UNCONFIRMED&bug_status=NEW&bug_status=ASSIGNED&bug_status=REOPENED
https://bugzilla.gnome.org/enter_bug.cgi?product=nautilus-actions
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5.2. Limitaciones conocidas

Modo de ejecución As of version 3.0, execution mode may be configured in Nautilus-Actions Configuration Tool but is not yet
honored by Nautilus plugin.

This concern working directory, execution mode, startup notification and execution’s owner parameters.

Atajo de teclado sugerido As of version 3.0, suggested shortcut, as described in DES-EMA specification cannot be configured
in Nautilus-Actions Configuration Tool, and is not honored by Nautilus plugin.

Separador de menú As of version 3.0, menu separators cannot be configured in Nautilus-Actions Configuration Tool, and are
not honored by Nautilus plugin.

One has to note that, for now, Nautilus file manager does not allow its plugins to define separators in the context menu.

6. About Nautilus-Actions Configuration Tool

The first version of Nautilus-Actions was initially written by Frederic Ruaudel (grumz@grumz.net) and Rodrigo Moya (rodrigo@gnome-
db.org). It has been thoroughly improved and is currently maintained by Pierre Wieser (pwieser@trychlos.org).

Artwork is due to courtesy of Ulisse Perusin (uli.peru@gmail.com) and DragonArtz (http://www.dragonartz.net).

To find more information about Nautilus-Actions, please visit the http://www.nautilus-actions.org/ Nautilus-
Actions website.

To report a bug or make a suggestion regarding Nautilus-Actions, the Nautilus-Actions Configuration Tool or this manual, follow
the directions in the GNOME Feedback Page, or you may prefer, at your convenience, directly open a bug or a request for
enhancement in Bugzilla website.

A. GNU Free Documentation License

Versión 1.3, 3 noviembre de 2008

Copyright © 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc.

Se permite la copia y distribución de copias literales de este documento, pero no se permite su modificación.

0. PREÁMBULO

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the sense of
freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially
or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their work, while not
being considered responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free in the same
sense. It complements the GNU General Public License, which is a copyleft license designed for free software.

Hemos diseñado esta Licencia para usarla en manuales de software libre, ya que el software libre necesita documentación libre:
Un programa libre debe venir con los manuales que ofrezcan la mismas libertades que da el software. Pero esta licencia no se
limita a manuales de software; puede ser usada para cualquier trabajo textual, sin tener en cuenta su temática o si se publica como
libro impreso. Recomendamos esta licencia principalmente para trabajos cuyo fin sea instructivo o de referencia.

1. APLICABILIDAD Y DEFINICIONES

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright holder saying it
can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free license, unlimited in duration,
to use that work under the conditions stated herein. The “Document”, below, refers to any such manual or work. Any member
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mailto:grumz@grumz.net
mailto:rodrigo@gnome-db.org
mailto:rodrigo@gnome-db.org
mailto:pwieser@trychlos.org
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https://bugzilla.gnome.org/enter_bug.cgi?product=nautilus-actions
http://www.fsf.org/
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of the public is a licensee, and is addressed as “you”. You accept the license if you copy, modify or distribute the work in a way
requiring permission under copyright law.

Una ‘Versioń Modificada’ del Documento significa cualquier trabajo que contenga el Documento o una porcioń del mismo, ya
sea una copia literal o con modificaciones y/o traducciones a otro idioma.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively with the relationship
of the publishers or authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that
could fall directly within that overall subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section
may not explain any mathematics.) The relationship could be a matter of historical connection with the subject or with related
matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant Sections, in the
notice that says that the Document is released under this License. If a section does not fit the above definition of Secondary then
it is not allowed to be designated as Invariant. The Document may contain zero Invariant Sections. If the Document does not
identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that
says that the Document is released under this License. A Front-Cover Text may be at most 5 words, and a Back-Cover Text may
be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specification is available
to the general public, that is suitable for revising the document straightforwardly with generic text editors or (for images composed
of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is suitable for input to text
formatters or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an otherwise
Transparent file format whose markup, or absence of markup, has been arranged to thwart or discourage subsequent modification
by readers is not Transparent. An image format is not Transparent if used for any substantial amount of text. A copy that is not
“Transparent” is called “Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input
format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML, PostScript or PDF designed for
human modification. Examples of transparent image formats include PNG, XCF and JPG. Opaque formats include proprietary
formats that can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or processing
tools are not generally available, and the machine-generated HTML, PostScript or PDF produced by some word processors for
output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the
material this License requires to appear in the title page. For works in formats which do not have any title page as such, “Title
Page” means the text near the most prominent appearance of the work’s title, preceding the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains XYZ in
parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific section name mentioned
below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.) To “Preserve the Title” of such a section
when you modify the Document means that it remains a section “Entitled XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the Document. These
Warranty Disclaimers are considered to be included by reference in this License, but only as regards disclaiming warranties: any
other implication that these Warranty Disclaimers may have is void and has no effect on the meaning of this License.

2. COPIA VERBATIM

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License,
the copyright notices, and the license notice saying this License applies to the Document are reproduced in all copies, and that
you add no other conditions whatsoever to those of this License. You may not use technical measures to obstruct or control the
reading or further copying of the copies you make or distribute. However, you may accept compensation in exchange for copies.
If you distribute a large enough number of copies you must also follow the conditions in section 3.

Usted también puede prestar copias, bajo las mismas condiciones establecidas anteriormente, y puede exhibir copias pública-
mente.
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3. COPIAR EN CANTIDAD

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering more than 100,
and the Document’s license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly,
all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also
clearly and legibly identify you as the publisher of these copies. The front cover must present the full title with all words of the
title equally prominent and visible. You may add other material on the covers in addition. Copying with changes limited to the
covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim copying in other
respects.

Si los textos requeridos para la cubierta son muy voluminosos para que ajusten legiblemente, debe colocar los primeros (tantos
como sea razonable colocar) en la verdadera cubierta y situar el resto en páginas adyacentes.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-
readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a computer-network location from
which the general network-using public has access to download using public-standard network protocols a complete Transparent
copy of the Document, free of added material. If you use the latter option, you must take reasonably prudent steps, when you
begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus accessible at the stated
location until at least one year after the last time you distribute an Opaque copy (directly or through your agents or retailers) of
that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of
copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICACIONES

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that
you release the Modified Version under precisely this License, with the Modified Version filling the role of the Document, thus
licensing distribution and modification of the Modified Version to whoever possesses a copy of it. In addition, you must do these
things in the Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous
versions (which should, if there were any, be listed in the History section of the Document). You may use the same title as
a previous version if the original publisher of that version gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the
Modified Version, together with at least five of the principal authors of the Document (all of its principal authors, if it has
fewer than five), unless they release you from this requirement.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.

D. Preserve all the copyright notices of the Document.

E. Añadir una nota de copyright apropiada a sus modificaciones, adyacente a las otras notas de copyright.

F. Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version
under the terms of this License, in the form shown in the Addendum below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Document’s license
notice.

H. Incluir una copia sin modificación de esta Licencia.

I. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year, new authors,
and publisher of the Modified Version as given on the Title Page. If there is no section Entitled “History” in the Document,
create one stating the title, year, authors, and publisher of the Document as given on its Title Page, then add an item
describing the Modified Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and
likewise the network locations given in the Document for previous versions it was based on. These may be placed in the
“History” section. You may omit a network location for a work that was published at least four years before the Document
itself, or if the original publisher of the version it refers to gives permission.
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K. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and preserve in the
section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the
equivalent are not considered part of the section titles.

M. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

N. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant Section.

Ñ. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no
material copied from the Document, you may at your option designate some or all of these sections as invariant. To do this, add
their titles to the list of Invariant Sections in the Modified Version’s license notice. These titles must be distinct from any other
section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified Version by
various parties — for example, statements of peer review or that the text has been approved by an organization as the authoritative
definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to the
end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text may
be added by (or through arrangements made by) any one entity. If the Document already includes a cover text for the same cover,
previously added by you or by arrangement made by the same entity you are acting on behalf of, you may not add another; but
you may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to
assert or imply endorsement of any Modified Version.

5. COMBINAR DE DOCUMENTOS

You may combine the Document with other documents released under this License, under the terms defined in section 4 above
for modified versions, provided that you include in the combination all of the Invariant Sections of all of the original documents,
unmodified, and list them all as Invariant Sections of your combined work in its license notice, and that you preserve all their
Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with
a single copy. If there are multiple Invariant Sections with the same name but different contents, make the title of each such
section unique by adding at the end of it, in parentheses, the name of the original author or publisher of that section if known, or
else a unique number. Make the same adjustment to the section titles in the list of Invariant Sections in the license notice of the
combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming one section
Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections Entitled “Dedications”. You
must delete all sections Entitled “Endorsements”.

6. COLECCIONES DE DOCUMENTOS

You may make a collection consisting of the Document and other documents released under this License, and replace the indi-
vidual copies of this License in the various documents with a single copy that is included in the collection, provided that you
follow the rules of this License for verbatim copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this License, provided you insert
a copy of this License into the extracted document, and follow this License in all other respects regarding verbatim copying of
that document.
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7. AGREGACIONES CON TRABAJOS INDEPENDIENTES

A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a volume of
a storage or distribution medium, is called an “aggregate” if the copyright resulting from the compilation is not used to limit the
legal rights of the compilation’s users beyond what the individual works permit. When the Document is included in an aggregate,
this License does not apply to the other works in the aggregate which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one half
of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket the Document within the aggregate,
or the electronic equivalent of covers if the Document is in electronic form. Otherwise they must appear on printed covers that
bracket the whole aggregate.

8. TRADUCCIÓN

Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section
4. Replacing Invariant Sections with translations requires special permission from their copyright holders, but you may include
translations of some or all Invariant Sections in addition to the original versions of these Invariant Sections. You may include
a translation of this License, and all the license notices in the Document, and any Warranty Disclaimers, provided that you
also include the original English version of this License and the original versions of those notices and disclaimers. In case of a
disagreement between the translation and the original version of this License or a notice or disclaimer, the original version will
prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (section 4) to Pre-
serve its Title (section 1) will typically require changing the actual title.

9. TERMINACIÓN

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provi-
sionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the copyright
holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the
violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work)
from that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from
you under this License. If your rights have been terminated and not permanently reinstated, receipt of a copy of some or all of
the same material does not give you any rights to use it.

10. REVISIONES FUTURAS DE ESTA LICENCIA

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from time to time.
Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.
See Copyleft.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered
version of this License “or any later version” applies to it, you have the option of following the terms and conditions either of
that specified version or of any later version that has been published (not as a draft) by the Free Software Foundation. If the
Document does not specify a version number of this License, you may choose any version ever published (not as a draft) by the
Free Software Foundation. If the Document specifies that a proxy can decide which future versions of this License can be used,
that proxy’s public statement of acceptance of a version permanently authorizes you to choose that version for the Document.

http://www.gnu.org/copyleft/
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11. RELICENSING

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes copyrightable
works and also provides prominent facilities for anybody to edit those works. A public wiki that anybody can edit is an example
of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained in the site means any set of copyrightable works
thus published on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons Corporation, a
not-for-profit corporation with a principal place of business in San Francisco, California, as well as future copyleft versions of
that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published under this
License somewhere other than this MMC, and subsequently incorporated in whole or in part into the MMC, (1) had no cover
texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at any time before
August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

Para usar esta licencia en un documento que usted haya escrito, incluya una copia de la Licencia en el documento y ponga el
siguiente copyright y notificación de licencia justo después de la página de título:

Copyright © YEAR YOUR NAME

Permission is granted to copy, distribute and/or modify this document under the
terms of the GNU Free Documentation License, Version 1.3 or any later version
published by the Free Software Foundation; with no Invariant Sections, no
Front-Cover Texts, and no Back-Cover Texts. A copy of the license is included in
the section entitled “GNU Free Documentation License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with. . . Texts.” line with this:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts
being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two alternatives to suit
the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in parallel under your
choice of free software license, such as the GNU General Public License, to permit their use in free software.


